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Tick-It! Trak Pro Product Overview 
 

 
Tick-It! Trak Pro is a member of the Tick-It! family of box office software.  It is designed to offer fast and efficient sales 
for General Admission Attractions, such as Theme Parks, Cinemas and Museums; as well as Reserved Seating events, 
such as Sports Venues and Performing Arts Centers. 
 
Tick-It! Trak Pro also provides the same fast and easy user interface for your Concession and Souvenir Sales! 
 
In addition to this manual, use the SEARCH or CONTENTS feature of the HELP Engine to look for a specific topic. 
 
Tick-It! Trak Pro Software Modules 
 
The Tick-It! Trak Pro system consists of software modules that are purchased and deployed to provide the functionality 
required for the intended application.  At a minimum, there are three modules that are required to deploy the system, and 
they are indicated as such below.  The modules are: 
 
The ADMIN Module (required) 
The POS Module (required) 
The REPORT Module (required) 
The INVENTORY Module (optional, but needed for retail sales operations) 
The VALIDATION Module (optional, but needed for Census tracking) 
The PACKAGE Module (optional, but needed for easy multiple event sales and seat renewals) 
The INTERNET TICKETING ASP Application (optional, but needed for Web Based Sales, if desired) 
The CRYSTAL REPORTS writer from Crystal Decisions  (optional, but strongly recommended, as it is needed for custom 
reporting, if desired) 
 
A brief description of the functions of each module follows: 
 
The ADMIN Module 
This is the module that supervisors or administrators use to set up Attraction Schedules, Ticket Prices, Ticket Designs, 
POS Station Options, Operator Security settings and other manager duties.  From this module your season of attractions 
is entered and maintained.  
 
The POS Module 
This is the Point of Sale interface, which allows transactions to take place.  It is written to take advantage of touch screen 
stations, although a standard keyboard and mouse will also work.  This is the module that does the actual 
transactionswith the public, selling tickets, refreshments, souvenirs, etc. 
 
The REPORT Module 
This is another management tool that allows you to produce a variety of pre made and custom reports.  All the reports of 
the Tick-It! Trak Pro system are designed and maintained using Crystal Reports, and can be modified using that 
program.  Crystal Reports is available separately from Business Objects.  In many organizations, there is usually a copy 
of Crystal Reports already on hand.  It is a common report writing program. This is the module covered by this manual.  
 
The INVENTORY Module 
This module allows you to enter inventory items for retail sale, and to lay out and configure your POS Station Menus for 
sale of such items.  You can maintain lists of suppliers (vendors), issue purchase orders to them and receive inventory 
from them.  
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The VALIDATION Module 
The Validation Module is an interface for “scanning” barcodes on your tickets to record and track actual usage.  This 
module can be used manually, with an attendant scanning tickets or entering in the ticket ID number, or this module can 
be interfaced to custom turnstiles, which will unlock automatically upon presentation of a valid ticket.  In amusement park 
environments, season passes and multi-use tickets are often issued, frequently in the form of tough plastic cards.  As long 
as they have the proper barcode issued by Trak Pro, this module will read them like any other ticket. 
 
The PACKAGE Module 
The Package Module allows you to sell flexible, multiple attraction packages in a few steps.  With the Package Module, 
you can re-assign the same seats to your customer (if available) from one season to the next.  You can mix venues, mix 
seating types, allow for “Customer Chooses X Attractions from Y Selections”, specify revenue splits and more. 
 
The KIOSK Module 
The Kiosk Module allows you to set up self service stations so that customers may purchase tickets with a credit card.  As 
of this writing, this module is still under development. 
 
The INTERNET TICKETING ASP Application 
This is an independent web based application based on Microsoft’s IIS Active Server Pages technology.  This application 
is licensed for use on your server on a per transaction basis.  A server within your domain becomes your 24/7 Internet 
ticketing processor.   Ticket sales are performed using your live database and are recorded in real time.   Users can select 
their seats after seeing the view from a given section.   
CRYSTAL REPORTS from Crystal Decisions 
This is the report writer used by the Tick-It! Trak Pro system.  Existing reports can be modified, and new ones created.  
Strictly speaking, it is an optional component. However, it is strongly recommended that you obtain Crystal Reports. It is 
an industry standard report writer. Check your current software, to see if you already own this package.   
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 Module Installation 
 
When Tick-It! Trak Pro was initially installed, the option is given to install the report module.   

 
 
If the report option was not selected at the initial set up, follow these instructions to install Tick-It! Trak Pro: 
 
INSTALLING TICK-IT! TRAK PRO: 

 
Insert the Tick-It! Trak Pro CD-ROM into your computer’s drive.  Start the SETUP 
process by clicking on the START menu. 
Select RUN.   
 
Type D:\SETUP.EXE  (where D is the letter of your CD-ROM drive) 
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The SETUP welcome screen will 
appear.  Make sure that no other 
programs are running.   
 
Click the OK button to proceed. 
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Click on the Square Button to 
automatically install Tick-It! Trak 
Pro. It will install in  the default 
directory: 
 
C:\ProgramFiles\Tick-It! Trak Pro 
 
 
If you do not want to install the 
program to Drive C, you will be 
given an opportunity to change the 
destination installation directory.  
 
 
As long as your local drive C has 
sufficient space, the default 

installation directory is the preferred installation directory. 
 
 
Once you select the destination directory, you are presented with a dialog of components and sample data for installation.  
Check the desired modules and sample data, and click NEXT… 
 
NOTE: Make sure that Install REPORT Module is checked. 
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For each of the selected Modules, you will be able to 
specify a Windows Program Group.  The default is to put 
a shortcut to each module and its corresponding help file 
in its own group.  You may change these groups to suit 
your own desktop / menu organizational style. 
 
 
Once you choose the groups for the Modules, files will 
begin copying. 
 
 
 
 
 
 
 
 

 
 
 
 
During the file copy process, a status bar is 
displayed, indicating progress. 
 
 
 
 
 

 
 
 
 
 
 
If, during the copying process, SETUP identifies a file 
that is OLDER than a file currently on your system, 
SETUP will pause, and prompt you for a decision.  
You will be asked if you wish to KEEP the NEWER 
file. 
 
 
Notice that the YES TO ALL button is highlighted in 
green.  It is our recommendation that you select YES 
TO ALL if a new file is detected. 
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Once all file copying is complete, any 
sample database sets you have selected 
will be initialized for first use.  You will be 
shown a progress dialog, as this procedure 
might take a few minutes. 
 
 
 
 
 
 
 

 
 
After initialization of any sample databases is finished, the 
program is installed.  You will see the following confirmation. 
 
 
 
 

 
 
 
 
 
At the end of the installation, a 
gentle reminder to register your 
purchase will appear. 
 
 
 
 
 
 
 
 
 
 
 

Once the program modules are installed, you might have to upgrade the Microsoft Data Access Components (MDAC).  
You will have to install the DSI Client for Mercury Payments if you have installed the POS Module, KIOSK Module or 
PACKAGE Module.   Refer to the ADMIN Module for upgrading MDAC.  
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Data Source 
 

 
The “Data Source” is the location specified for the program 
to search for database, report, configuration and other 
needed files.   
 
 
 
 
 
 
 
At installation, the default is the directory (or “Folder”) where 
you installed the program.   
 
If you are running in a networked environment, and need to 
share the data with other users, you will most likely need to 
change the working directory on each station running the 
program.  T 
 
 
 
 
 
 
 
 
 

 
Typically, the directory would have been already created on the server by your network administrator, and the necessary 
files already copied. 
 
Once the Data Source has been changed, the program will need to re-start, in order to load the new data. 
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REGISTRATION / MODULE ACTIVATION: 
 
When you install the Tick-It! Trak Pro Modules on your computer, the default license is for a 30 day demo on all modules.  
With your purchase if Tick-It! Trak Pro, you are issued an UNLOCK code. 
 
From the ADMIN Module, select CHANGE LICENSING from the OPTIONS menu: 
 
 

 
 
Enter your company name and address, and enter the unlock code in the field indicated. 
 

 
 
When you are certain the unlock code is entered correctly, click on the CHANGE LICENSING button.  After licensing is 
changed, you will have to restart any Trak Pro modules currently running on the computer for the licensing to take effect. 
 
This procedure will need to be repeated at all stations with Tick-It! Trak Pro installed. 
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NETWORK (MULTI-USER) CONSIDERATIONS: 
 
If you are running Tick-It! Trak Pro on multiple stations in a networking environment, here are some deployment 
considerations to keep in mind: 
 
Each workstation must have the appropriate Trak Pro Modules installed LOCALLY.  This means you must run the SETUP 
program at each computer, and specify a LOCAL drive for the destination.  The system is designed to share the DATA 
from your server, not the PROGRAM. 
 
Each POS, PACKAGE, KIOSK or VALIDATION station MUST have a UNIQUE ID Specified in the station options. This is 
VERY IMPORTANT, as the Station ID is used to resolve record locking and possession conflicts.  NO TWO STATIONS 
can share the SAME ID! 
 
If you are using MS-ACCESS 2000 as the “Back End” database, then make sure you have NETBIOS enabled for your 
networking protocols. 
 
The Trak Pro modules expect to be able to use their installation directory as a “scratch pad” space for temporary files and 
such.  Make sure that your network users have privileges to read, write, create and delete files in the Trak Pro installation 
directory. 
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Selecting a Sample Data Set 
 

When Tick-It! Trak Pro is set up, you are 
given the opportunity to install any or all 
of seven different sample data sets. 
Working with a sample data set allows 
you to evaluate the program.   
 
At the initial start-up of any Tick-It! Trak 
Pro Module, you are presented with a 
choice of data sets.   
 
Note: All of these choices may not be 
available to you, if they were not installed 
during the program set up. 
 
 
 
 
 
 
 
In addition to an “empty” data set to begin work for your own organization, the seven sample data sets are as follows: 
 
Baseball 
This example uses “Podemska Chicken Hawks” minor league ball club to illustrate typical sporting event ticketing.  There 
is a 71 game season pre-programmed for the Chicken Hawks at their home of Podemska Field, which has 16,361 
reserved seats and 2000 general admission bleacher seats.  Concessions and souvenirs have also been added for you. 
 
Cineplex 
This sample uses a Movie Cineplex called the Stellar Cinemas.  There are 8 movie theaters and a pre-loaded schedule of 
popular movies.  All the seats offered are General Admission.  Concessions and souvenirs have also been added for you. 
 
College Sports 
Podemska City College has two venues for its sporting events: 
(a)  Podemska Football Field with 36035 Reserved Seats and 2000 General Admission Seats 
(b)  Podemska Arena with 6967 Reserved Seats and 2000 General Admission Seats 
Concessions and souvenirs have also been added for you. 
 
Science Museum 
The Tri-City Science Museum serves as an example of typical museum ticketing.  The museum is mostly a general 
admission facility, with an IMAX theater and Planetarium, but there are some special events which require reserved 
seating.  Concessions and souvenirs have also been added for you. 
 
Performing Arts 
The AMB Performing Arts Center is a large facility with 3 different venues: 
(a)  There is the large Amphitheater, with 3000 General Admission Lawn Seats and 6421 Reserved Seats 
(b)  There is the Main Stage Theater with 699 Reserved Seats and 
(c)  The Bantam Theater, with 184 Reserved Seats. 
Concessions and souvenirs have also been added for you. 
 
Motorsports 
The AMB Motorsports Speedway is home to all kinds of exciting racing.  Admission is mixed with 4000 General Admission 
Grandstand seats, as well as 2140 Reserved Seats along with Pit Access.  Concessions and souvenirs have also been 
added for you. 
 
Theme Park 
The World of Fun Amusement park is actually two parks in one!  There is World of Fun, a conventional “roller coaster” 
type park, as well as “World of Water”, a super-splashing and sliding water park.  Admission to the parks is separate, and 
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there are some reserved seating shows, and special park rides that tickets can be purchased for.  Concessions and 
souvenirs have also been added. 
 

 
In the example above, the operator has selected the Science Museum Data set to begin work with. 
 
The best way to either evaluate our software demo, or to initiate user training, is to select a sample data set that most 
closely matches your organization. 
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Accessing the Report Module 
 
From the ADMIN Module Menu, select Reports.  
 

 
 
This opens the Report Module.  You will see a screen similar to this:  
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The Main Menu 
 

 
The Main Menu of the Report Module is where you select reports or other operations.  As with other standard Windows 
applications, menus are positioned at the top of the form, and drop down to reveal your choices. 
 
NOTE:  If you do not have the optional Tick-It! Trak Pro INVENTORY Module, your Main Menu will NOT include the 
Inventory selection. 
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The File Menu 
 
The selections on the File Menu are to Exit the program, and Validate the Data Base.  The other menu choices offer 
report groupings, configuration options or help. Shortcut keys are underlined.  For example, drop down the Customers 
Menu by pressing ALT-C. 

 
 
When you have finished working in 
the Report Module, click or press 
Exit to exit the program.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
It is recommended that you validate your database at each start-up. Click or press Validate TrakProDatabase to begin 
validation.  
 

 
 
You will see this screen when validation is complete. The process takes less than 
one minute.  
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The Ticketing Menu 
 
 

 
From Ticketing Menu you access all reports relating to Tickets, Ticket Sales and Attendance.  There is a Sub Menu for 
Sales and Attendance Reporting: 
 
 

 
From the Sales and Attendance Sub-Menu, there is another Sub-Menu for Multiple Ticket Usage Reports: 
 

 
The following reports are available from this menu. 
 
Attraction Schedule Report 
List of Ticket Types 
Standard Sales and Attendance Reports 
Hourly Census Report 
Ticket Usage by Date Report 
Ticket Usage Over-All Totals Report 
Ticketing by Customer Report 
Attendance vs. Weather Report 
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 The Inventory Menu 
 
NOTE:  If you do not have the optional Tick-It! Trak Pro INVENTORY Module, your Main Menu will NOT include the 
Inventory selection 
 

 
All reports based on Inventory Items and Suppliers are found here. 
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The Transactions Menu 
 
 

 
The Transactions Menu allows you to run reports based on Point of Sale transactions.  For convenience, there is a Sub-
Menu of reports that automatically take today’s date as input, to show you transactions for the day.  That Sub-Menu is 
shown here: 
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The Customers Menu 
 
 

 
All reports based primarily on Customer Records and Memberships can be found here. 
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 The Misc (Miscellaneous) Reports Menu 
 

 
This menu contains reports that did not lend themselves to being grouped with the others. 
 
POS Operator List Report 
POS Station Report 
Operator Login Report 
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The Options Menu 
 
 

 
There are two options to set for the Report Module: 
 
(1) Your Data Source,  and 
(2) Any Background Image for the Main Screen of the Report Module 
 
When selecting your background appearance for the program, the Options Menu expands to give you your background 
choices as shown here: 
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Selecting A Picture 
 
For setting the computer background, or for printing a design, select either a Windows Bitmap (BMP) or Compressed 
(JPG) picture file.   

 
This form acts as a file location browser, and displays a 
thumbnail view of any highlighted image file.  The 
ACTUAL picture size in pixels (dots) is also shown. 
 
To select a picture, browse the Drive and 
Folder/Directory lists.   
 
Click on the desired file.   
 
A preview will appear, allowing you to determine that it 
is the correct file.  
 
In this example, this “Chicken Hawks” Logo is 150 x 150 
pixels, a good size for printing on a receipt.   
 
 
Click the OK button to confirm your selection. 
 
 
 Click CANCEL if you change your mind. 
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The Help Menu 
 
 

 
The Help Menu provides assistance for users of the program.  In addition to calling up this Help File, the Tips for Novice 
Users feature can be enabled.  This allows helpful hints to automatically pop up during complex areas of the program. 
 
Help can also be summoned from any portion of the program by pressing F1. 
 
 

Tips for Novice Users 
 

 
 
This feature automatically displays a 
helpful hint window during complex 
operations.  This is intended as a passive 
training tool.   
 
Once you are comfortable with the 
system, turn this feature off if it annoys 
you. 
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About the Program 
 

 
This window details the version number and 
licensing information for the currently running 
copy of the Program.  View computer system 
information as well from this selection. 
 
When calling for tech support, NCS personnel 
might request that you open this window to 
check the version number.   
 
 
 
 
 
 
 
 
Click on the SYSTEM INFO button, to view a 
detailed listing of your computer’s hardware 
and software 
 
 
 

A manifest will be produced, as shown below: 
 
 
An NCS Tech Support 
representative might ask you 
to open this form. 
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Specifying a Date Range for a Report 
 
Many reports allow or require a date range in order to run.  Specifying a date range for any report operation is the same, 
no matter which report you are running.  Below is the cluster of controls common to all date range entry forms: 
 
 

 
The Start Date and End Date entry 
fields are shaded light blue.  This 
indicates that the field is locked.  You 
cannot type in this field.   
 
Enter dates by selecting them from the 
calendar on the screen.  This prevents 
the entering of invalid dates, such as 
02/31/2003. 
 
 
 
Below the calendar are 4 arrow 
buttons.  The outer buttons increase or 
decrease the displayed calendar by 1 
year.  The inner buttons increase or 
decrease the displayed calendar by 1 
month. 

 
To set the Start Date or End Date, click on the desired date.  Then, click the SET START DATE or SET END DATE 
button, located below the calendar arrow buttons. 
 
These controls do an instant check for “foolish” entries. If you specify an END DATE that is prior to the START DATE, the 
program will automatically switch them.  Keep this in mind when setting your dates.  Try setting the END DATE first, to 
avoid the program switching dates unexpectedly. 
 
 
These reports allow or require a date range: 
 
Transaction Related Reports: 
Transaction Reports 
Top Merchandise Sellers 
Operator Login Report 
Cash Drawer Closing Reports 
 
Attraction / Ticketing Related Reports: 
Attraction Schedule Report 
Standard Sales and Attendance Reports 
Attendance vs. Weather Report 
Ticketing by Customer Report 
 
Customer Related Reports: 
Customer Listing Report 
Expired Memberships Report 
Top N Customers Report 
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The Crystal Report Viewer 
 
Most reports generated by the Tick-It! Trak Pro Report Module are created and maintained using the Crystal Reports 
Designer, available from Crystal Decisions. 
(their website is www.CrystalDecisions.com) 
 
When you run a Crystal Report from the Report Module, a Preview Form will appear:  

 
 
 
 
 
 
 
By default, the viewer will 
set the scaling to attempt 
to show you the entire 
page of the report, 
assuming that it is 
formatted for an 8 ½ by 
11 sheet of paper. 
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At the top you will see a set of controls.  These allow you to work with the report you are previewing.  Here is a detailed 
explanation: 
 
 

 
Clicking on the printer icon sends the report to your default printer. To change printers, click on the PRINTER button at the 
bottom of the viewer. 
 
Clicking on the envelope icon allows you to export the report in a variety of formats.  The exported file can be sent to a 
disk.  The file can also be emailed, if you have the appropriate email client and web connection. 
 
Clicking on the lightning bolt icon causes the report to be re-generated, using the latest available data.  This is useful in 
networking environments, where transactions are occurring all the time, and you want to see current results. 
 
The pull down control with percentages allows you to set the zoom level of the preview.  The report image can be 
enlarged or reduced. 
 
The middle controls are for page navigation through the report. 
 
The icon with the magnifying glass invokes a search wizard, to allow you to quickly locate an item of interest in a lengthy 
report. 
 
 
The Following are NOT Crystal Reports: 
These reports are generated from internal code used by Tick-It! Trak Pro, and are built into a spreadsheet for viewing 
prior to printing.  You cannot modify these reports using the Crystal Reports editor.  These reports ARE NOT displayed 
using the Crystal Reports Viewer. 
 
Hourly Census Report 
Repeating Ticket Usage by Date Report 
Repeating Ticket Usage Over-All Totals Report 
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Attraction Schedule Report 
 

 
 
 
 
 
 
 
 
 
 
Click on the date controls to set a date range for the report.   
 
 
 
 
Select the desired report from the pull down list.   
 
Click the PRINT button to preview the report. 

 
To see the report selection formula passed to the Crystal Report generator, click the FORMULA button.  This can be a 
useful aid in learning how to write custom reports, and debugging custom reports you have written. 
 
 
This report is defined by the file: 
Schedule.rpt 
 
To modify or customize this report, use the Crystal Reports Designer to edit the file: 
Schedule.rpt 
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Attraction Sales Reports 
 

 
 
Attraction Sales Reports allow you to see your ticketing 
sales / attendance for a specified date range. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Tick-It! Trak Pro ships with several pre-defined Attraction Sales Reports created using Crystal Reports.  All templates for 
transactions reports start with the letters “TIX”, and end with the file extension “.RPT”.   
 
Tick-It! Trak Pro assumes that any file matching this pattern found in your working directory is an Attraction Sales Report 
template.  Use this to your advantage, when creating custom attraction sales reports. Name them “TIXsomething.RPT,”  
and they will automatically appear in the selection list . 
 
Click on the date controls to set a date range for the report.  Select the report you want from the list in the pull down 
control.  Click PRINT to preview the report. 
 
To see the report selection formula passed to the Crystal Report generator, click the FORMULA button.  This can be 
useful in learning to write custom reports, and debugging custom reports you have written. 
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Hourly Census Reports 
This reporting tool is essential for large, all day attractions such as amusement parks, fairs, zoos, museums and trade 
shows.  A breakdown of attendance for any selected date in your schedule, in intervals as short as 15 minutes can be 
obtained.   

 
 
 
 
 
Click on the 
Calendar and 
Clocks to change 
the Date, Start 
and End Times 
and reporting 
intervals.  
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Follow these steps to analyze your day’s attendance: 
 

 
Select the starting time, ending time and reporting interval using the digital clocks, as shown above. 
 
Click on the desired date for reporting on the calendar. 
Click on the REFRESH DISPLAY button. 
 
This report could take a few minutes to generate. 
 
Once the report has been tabulated, print the grid by clicking on the PRINT CURRENT DISPLAY button. 
 
To save the report as a tab delimited file for importing into MS Excel or other application, click on the SAVE AS TAB 
DELIMITED FILE FOR EXCEL button. 
 
Note that this is one of the few reporting features that is NOT based on a Crystal Report.  You cannot modify them 
externally. 
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Repeat Visits by Date Report 
 
A breakdown of repeated ticket usage (for Attractions that allow multiple visits) from validated attendance for any selected 
date is available.   

 
This reporting tool is 
essential for large 
attractions such as fairs, 
zoos, amusement parks, 
museums and trade 
shows that allow repeat 
visits using a single 
ticket purchase.   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Follow these steps to analyze your day’s attendance: 
 
Click on the desired date for reporting on the calendar. 
 
Click on the REFRESH DISPLAY button. 
 
This report could take a few minutes to generate. 
 
Once the report has been tabulated, print the grid by clicking on the PRINT CURRENT DISPLAY button. 
 
Save the report as a tab delimited file for importing into MS Excel or other application by clicking on the SAVE AS TAB 
DELIMITED FILE FOR EXCEL button. 
 
NOTE: This is one of the few reporting features that is NOT based on a Crystal Report.  You cannot modify this report. 
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Repeating Ticket Usage Over-All Totals 
A breakdown of repeated ticket usage (for Attractions that allow multiple visits) from actual validated attendance for your 
entire season to date is available.    

 
 
This report is essential 
for attractions such as 
fairs, zoos, amusement 
parks, museums and 
trade shows that allow 
repeat visits using a 
single ticket purchase.   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Follow these steps to analyze your season’s repeating ticket attendance: 
 
Click on the REFRESH DISPLAY button.  The program uses the system date to determine the end date. 
 
This report could take a few minutes to generate. 
 
Once the report has been tabulated, print the grid by clicking on the PRINT CURRENT DISPLAY button. Save it as a file 
for importing into MS Excel or other application by clicking on the SAVE AS TAB DELIMITED FILE FOR EXCEL button. 
 
NOTE: This is one of the few reporting features that is NOT based on a Crystal Report. You cannot modify this report 
externally. 
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Attendance vs. Weather Report 
 
This is a report detailing each day of your facility’s attendance along with the weather conditions for that day. 
 

 
 
 
This reporting tool is essential for large outdoor 
attractions such as fairs, amusement parks, zoos, 
amphitheaters and trade shows. 
 
 
 
 
 
Select the desired Start and End Dates. 
 
 
 
 
Click the PRINT REPORT button. 
 

 
This report is defined by the file: 
WeatherReport.rpt 
 
To modify or customize this report, use the Crystal Reports Designer to edit the file: 
WeatherReport.rpt 
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Ticketing Sales by Customer 
 

 
 
Tick-It! Trak Pro  is shipped with several pre-defined Tickets By Customer Reports created using Crystal Reports.  These 
templates for transactions reports start with the letters “TBC”, and end with the file extension “.RPT”.   
 
Tick-It! Trak Pro assumes that any file matching this pattern that it finds in your working directory is a Tickets By 
Customer Report template.  Use this to your advantage, when creating custom tickets by customer reports.  Name them 
“TBCsomething.RPT” and they will automatically appear in the selection list  
 
Click on the date controls to set a date range for the report.  Select the desired report from the pull down list.  Click the 
PRINT button to preview the report. 
 
To see the report selection formula passed to the Crystal Report generator, click the FORMULA button.  This can be a 
useful aid in learning how to write custom reports, and debugging custom reports you have written. 
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List of Ticket Types 

This report prints a listing of all defined Ticket Types and Default Prices.  No user input is required to produce the report. 
This report is defined by the file: TicketType.rpt 
 
To modify or customize this report, use the Crystal Reports Designer to edit the file: TicketType.rpt 
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Inventory Re-Order Report 
 
This report prints a listing of all inventory items that have a Quantity On Hand lower than the Re-Order Point.  No user 
input is required to produce the report. 
 
 
 
Use this report to help decide what you need to buy to bring your stock up to normal operating levels.   
 
This report is defined by the file: 
InventoryReOrder.rpt 
 
To modify or customize this report, use the Crystal Reports Designer to edit the file: 
InventoryReOrder.rpt 
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Inventory On Hand Report 
 
This report prints a listing of all inventory items in your database.   No user input is required to produce the report. 
Use this report to detail the actual worth of your merchandise on hand. 
 
This report is defined by the file: 
InventoryOnHand.rpt 
 
To modify or customize this report, use the Crystal Reports Designer to edit the file: 
InventoryOnHand.rpt 
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Supplier Listing Report 
 
This report prints a listing of all Suppliers (vendors) in your database.  You would use this report as a handy phone book 
or reference for authorized vendors for your organization.  No user input is required to produce the report. 
 
This report is defined by the file: 
SupplierListing.rpt 
To modify or customize this report, use the Crystal Reports Designer to edit the file: 
SupplierListing.rpt 
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Today's Transactions by Operator 
 
This report prints a listing of all transactions for the day, grouped by Operator.  No user input is required to produce the 
report. 
 
This report is defined by the file: 
TransByOperator.rpt 
 
To modify or customize this report, use the Crystal Reports Designer to edit the file: 
TransByOperator.rpt 
 
 



Chapter 3 The Reports 

REPORT Manual Page 41 
Copyright 2004 New Concepts Software, Inc. 

Today's Transactions by POS Station 
 
This report prints a listing of all transactions for the day, grouped by POS Station.  No user input is required to produce the 
report. 
 
This report is defined by the file: 
TransByStation.rpt 
 
To modify or customize this report, use the Crystal Reports Designer to edit the file: 
TransByStation.rpt 
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Today's Transactions by Payment Type 
 
This report prints a listing of all transactions for the day, grouped by Payment Type.  No user input is required to produce 
the report. 
 
This report is defined by the file: 
TransByPayment.rpt 
 
To modify or customize this report, use the Crystal Reports Designer to edit the file: 
TransByPayment.rpt 
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Transaction Reports 
 
 

 
Click on the date controls to set a date range for the report.  Select desired report from the pull down list.   
 
Click the PRINT button to preview the report. 
 
To see the report selection formula passed to the Crystal Report generator, click the FORMULA button.  This is useful 
when learning how to write custom reports, and debugging custom reports you have written. 
 
 
This report is defined by the file: 
TRN-Skeleton.rpt 
To modify or customize this report, use the Crystal Reports Designer to edit the file: 
TRN-Skeleton.rpt 
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Top Product Sellers 
 
 
Tick-It! Trak Pro is shipped with several pre-
defined Top N Sales Reports constructed using 
Crystal Reports.   
 
All templates for transactions reports start with 
the letters “SALES”, and end with the file 
extension “.RPT”.   
 
Tick-It! Trak Pro assumes that any file 
matching this pattern that it finds in your 
working directory is a Top N Sales Report 
template.  Use this to your advantage when 
creating custom attraction sales reports.  Name 
them “SALESsomething.RPT” and they will 
automatically appear in the selection list as 
shown. 
 
Click on the date controls to set a date range 
for the report.  Select the desired report from 
the pull down list.   
 
Click the PRINT button to preview the report. 
 
 

To see the report selection formula passed to the Crystal Report generator, click the FORMULA button.  This is a useful 
aid when learning how to write custom reports, and debugging custom reports you have written. 
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Cash Drawer Closing Reports 
 
Tick-It! Trak Pro is shipped with several pre-defined Cash Drawer Closing Reports constructed using Crystal Reports.   
 
There are two kinds of Cash Drawer Closing Reports, Closing by Operator and Closing by POS Station.  The report you 
use depends on how your organization closes cash drawers at the end of a shift. 
 

 
If you track cash drawers By 
OPERATOR (where each clerk is 
issued their own drawer to use 
wherever they work), use the 
Closings By Operator reports.   
 
These templates start with the letters 
“CBO”, and end with the file 
extension “.RPT”. 
 
 
 
 
 
 

 
 
 
If you track cash drawers BY 
STATION (where each POS 
Station is issued its own drawer 
and multiple operators use that 
drawer during a shift), use the 
Closings By Station reports.   
 
These templates start with the 
letters “CBS”, and end with the 
file extension “.RPT”. 
 
Tick-It! Trak Pro assumes that 
any file if finds matching these 
patterns in your working directory 
is a Closing Report template.  
Use this to your advantage, when 
creating custom Closing reports.  
Name them “CBOsomething.RPT” or  “CBSsomething.RPT” and they will automatically appear in the selection list. 
 
Click on the date controls to set a date range for the report.  Select the desired report from the list presented in the pull 
down control.  Click the PRINT button to preview the report. 
 
To see the report selection formula passed to the Crystal Report generator, click the FORMULA button.  This is useful aid 
when learning how to write custom reports, and debugging custom reports you have written. 
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Customer Listing Reports 
 
Customer Listing Reports allow you to view customer records using fairly complex selection criteria. 
 
Generate reports for entire groups of customers: 
 

 
 
Or, Search for a particular customer type, transaction date range, or membership status.  Select groups of customers by 
city or zip code for mass mailings. 
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Generate reports based upon a single customer record, as shown here: 
 

Tick-It! Trak Pro comes with 
several pre-defined Customer 
Listing Reports created using 
Crystal Reports.  Templates 
for transactions reports start 
with the letters “CST”, and 
end with the file extension 
“.RPT”.   
 
Tick-It! Trak Pro assumes 
that any file matching this 
pattern found in your working 
directory is a Customer 
Listing Report template.  Use 
this when creating custom 
attraction sales reports.  If 
you name report files as 
“CSTsomething.RPT” they 
will automatically appear in 
the selection list. 

 
Click on the date controls to set a date range for the report.  Select the desired  report from the pull down list.   
 
Click the PRINT button to preview the report. 
 
To view the report selection formula passed to the Crystal Report generator, click the FORMULA button.  This is useful 
when learning how to write custom reports, and debugging custom reports you have written. 
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Customer Search 
 

 
 
Some reports allow you to choose a specific customer.  To search and browse through your customer database, use the 
Customer Search Form, pictured above.   
 
The customer search form has the following controls: 
 

 
Restrict your search by limiting it to a specific customer type, or 
entering text to search for in particular fields. 
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These command buttons 
execute the specific tasks 
noted in the Search Screen. 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 

 
 
 
 
 
These touch screen active controls 
allow the operator to key in characters 
without using the keyboard. 
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Select the field searched for the 
criteria entered.   
In this example, the query is run 
against the LAST NAME field, 
where the field entry starts with SMI. 
 
 
 
 
 
 
 
 
 
 
 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Highlight the desired customer.  
 
Click the THIS CUSTOMER 
button. 
 
 
 
 
 
 
 
 

 
If the customer is not found, create a new record for that person.  Click on the NEW CUSTOMER button.  Enter the 
information to create a new customer record.  
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Customer Type Report 
 
 

 
This report captures customer listings grouped by customer type.  
Select a single customer type, or a listing of all customer types.   
 
This report is faster than the more comprehensive Customer 
Listing Report, which allows more selection criteria to be entered. 
 
 
 
 
 
 
 
 

This report is defined by the file: CustomerTypes.rpt 
 
To modify or customize this report, use the Crystal Reports Designer to edit the file: CustomerTypes.rpt. 
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Membership Types Report 
 
This is a listing of the Membership Types your organization offers.   
 

 
 
Select a printout of All Membership Types, or a listing on the 
details of a single Membership Type. 
 
This report is defined by the file: MembershipType.rpt 
 
To modify or customize this report, use the Crystal Reports 
Designer to edit the file: MembershipType.rpt 
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Expired Memberships Report 
 
 

 
This report allows you to specify a date range to locate 
customers that have memberships expiring in that range.   
 
This report is a useful marketing tool to follow up with these 
customers to convince them to renew their memberships 
with your organization. 
 
 
 
 
 
 
 
 
 
 
 
 

 
This report is defined by the file: 
ExpiredMemberships.rpt 
 
To modify or customize this report, use the Crystal Reports Designer to edit the file: 
ExpiredMemberships.rpt 
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Top N Customers Report 
 
Tick-It! Trak Pro  is shipped with several pre-defined Top N Customer Reports created using Crystal Reports.  The 
templates for transactions reports start with the letters “TOP”, and end with the file extension “.RPT”.  Tick-It! Trak Pro 
assumes that any file matching this pattern is a Top N Customer Report template.  Use this to your advantage, when 
creating custom attraction sales reports. Name them “TOPsomething.RPT” and they will automatically appear in the 
selection list. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
Click on the date controls to set a date range for 
the report.   
 
 
 
Select the desired report from the pull down list. 
 
 
Click the PRINT button to preview the report 
 
 

To see the report selection formula passed to the Crystal Report generator, click the FORMULA button.  This is a useful 
aid in learning how to write custom reports, and debugging custom reports you have written. 
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Miscellaneous Reports 

Operator List Report 
 
This report lists all POS Operator records, or a specific operator record.   
 

 
This report captures employees allowed to operate POS Stations 
and the security permissions granted. 
 
 
 
 
 
 
 
 
 
 
 

 
This report is defined by the file: 
OperatorList.rpt 
 
To modify or customize this report, use the Crystal Reports Designer to edit the file: 
OperatorList.rpt 
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POS Station Report 
 

 
This report is a listing of your POS Station Definitions 
 
This report documents the type of sales activity allowed at 
each POS Station. 
 
Select a single POS Station, or a listing of all Stations.   
 
 
 
 
 
 
 
 
This report is defined by the file: 
POSStationList.rpt 
 
To modify or customize this report, use the Crystal Reports Designer to edit the file: 
POSStationList.rpt 
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Operator Login Report 
 
This report allows you to specify a date range to print POS Operator Login / Logout activity. 
 

 
This report is useful as a management tool to track the 
work habits of your POS Operators. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
This report is defined by the file: 
OperatorLogin.rpt 
 
To modify or customize this report, use the Crystal Reports Designer to edit the file: 
OperatorLogin.rpt 
 
 
 
 

 


